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OpenOffice.org is a powerful open-source office suite that provides tools for all types of office tasks such as

writing texts, working with spreadsheets, creating graphics and presentations, or designing scientific formulas.
With OpenOffice.org, you can use the same data across different computing platforms. You can also open and
edit files in other formats, including Microsoft Office, then save them back to this format. The OpenOffice.org
Novell Edition contains improved functionality and additional features not available with the standard version.

OpenOffice.org Novell Edition

SUSE® Linux Enterprise Desktop provides the Novell edition
of OpenOffice.org. The Novell edition has several enhance-
ments that are not included in the standard edition:

General

* Many performance improvements for a better user
experience

* Built-in extensions

* Google Docs and Zoho load and save

+ Support for Open Document Format (ODF) v1.2
Base

* Built-in extensions. Report designer for creating smart-
looking database reports.

Calc

Extended row limit (1,048,576 rows) and related per-
formance improvements

Improved load and save of files in . x1sx format.
Improved support for VBA macros.

Usability improvements in selections and copying.
Built-in extensions and non-linear solver.

* Support for Comments.
* New chart types, like Bubble.
Writer
* Improved load and save of files in .docx format.
* Built-in extensions for PDF import and MediaWiki ex-
port.
» Autocorrection improvements.
Impress
* Improved load and save of files in .pptx format.

* Built-in extensions provided: Presenter console for
better overview of the presenter (time, next slide);
Presentation minimizer to clean up the presentation
before sending it to others

Additionally, the following features are known from older
versions:

Excel VBA Macro Interoperability:
OpenOffice.org Novell edition eases the migration of
many macros from Microsoft Excel. Although not all
macros can be successfully migrated, this interoperability
offers more than the standard edition, which does not
support migration of macros.



Data Pilots:
Data Pilots are interoperable with Microsoft Office Pivot-
Tables*. OpenOffice.org Novell edition substantially im-
proves the Data Pilot feature, making it possible to edit
pilots after creation.

Enhanced Fonts:
Licensed fonts from Agfa* Monotype* which are metri-
cally identical and visually compatible with some of the
key Microsoft fonts. This allows OpenOffice.org Novell
edition to match fonts when opening documents origi-
nally composed in Microsoft Office, and very closely
match pagination and page formatting.

EMF+Support:
The ability to render EMF+ formatted graphics.

SVG Support:
The ability to import scalable vector graphics.

Import File Formats:
Microsoft Works, WordPerfect* text and graphics, T602
files, Office Open XML, and more.

GroupWise® Integration:
OpenOffice.org Novell edition includes improved integra-
tion with ODMA (Open Document Management Archi-
tecture) services, for example for GroupWise. If you have
the GroupWise client installed on the machine,
OpenOffice.org Novell edition will offer to open docu-
ments from GroupWise, or save documents in Group-
Wise.

You can also use the standard edition of OpenOffice.org
rather than the Novell edition. If you install the latest version
of OpenOffice.org, all of your Novell edition files remain
compatible. However, the standard edition does not contain
the enhancements made in the Novell edition.

For a full list of new core features available with OpenOf-
fice.org 3.2.0, refer to http://development
.openoffice.org/releases/3.2.0.html.

Compatibility

OpenOffice.org can work with documents, spreadsheets,
presentations, and databases in many other formats, includ-
ing Microsoft Office. They can be seamlessly opened like
other files and saved back to the original format. Though
some work has already been invested in interoperability,
occasionally there are still formatting issues. If you have
problems with your documents, consider opening them in
the original application and resaving them in an open format
such as RTF for text documents. In case of migration prob-
lems with spreadsheets however, it is advisable to resave
them as Excel files and use this as intermediate format (with
CSV format you would lose all cell formatting and CVS
sometimes leads to incorrect cell type detection for
spreadsheets).

OpenOffice.org Migration Guide

For useful information about migrating from other
office suites to OpenOffice.org, refer to the
OpenOffice.org Migration Guide at http://
documentation.openoffice.org/manuals/
oooauthors2/0600MG-MigrationGuide.pdf.

OpenOffice.org Modules

OpenOffice.org consists of several application modules
(subprograms), which are designed to interact with each
other. All modules feature the same graphical user interface
and similar functionality.

Table 1. The OpenOffice.org Modules

Module Usage

Writer Text document module

Calc Spreadsheet module

Impress Presentation module

Base Database module

Draw Vector graphics module

Math Mathematical equation module
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To start the OpenOffice.org suite, press Alt + F2, type
ooffice and press Enter. In the Welcome dialog, select
the module you want to open. If an OpenOffice.org appli-
cation is open, you can start any of the other applications
by clicking File — New — Name of Application.

Saving OpenOffice.org Files

1. To save a new file, select File — Save or Save as from
the Menu Bar or use the shortcut Ctrl + Shift + S.

2. Select the directory where you want to save the file.
3. Enter the filename in the Location box.

4. From the Filter box, select the file type in which you
want to save the file.
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In all modules you can save your documents as native
OpenOffice.org files, OpenOffice.org templates, Microsoft
files and StarOffice files.

Navigator and Navigation Shortcuts

The Navigator tool displays information about the contents
of a document. It also lets you quickly jump to different
elements. For example, you can use the Navigator to get a
quick overview of all images included in the document. To
open the Navigator, click Edit — Navigator or with F5. The
elements listed in the Navigator vary according to the
document loaded in Writer.

You can also navigate your files with the following shortcuts:

Table 2. Navigation Shortcuts

Action Shortcut

Delete Word Ctrl + Del or Ctrl + <—
End of Document Ctrl + End

End of Line End

Select All Ctrl + A

Start of Line Home

Top of Document Ctrl + Home

Word Left Ctrl + «

Word Right Ctrl + —

Using and Creating Templates

OpenOffice.org comes with a set of predefined templates,
and you can find additional templates on the Internet. If
you want to create your own templates, you need to deter-
mine what you want the document to look like and create
the styles you need in that template.

For text documents, spreadsheets, presentations, and
drawings, you can easily create a template from an existing
document as follows:

1. Start OpenOffice.org and open or create a document
that contains the styles that you want to use as a tem-
plate.

2. Click File — Templates — Save.

3. Specify a name for the template.

4. In the Categories box, click the category where you
want to place the template.

5. Click OK.

OpenOffice.org Writer

OpenOffice.org Writer is a full-featured word processor
with page and text-formatting capabilities. Its interface is
similar to interfaces for other major word processors, and
it includes some features that are usually found only in ex-
pensive desktop publishing applications. Many of the

OpenOffice.org Writer features apply also to other
OpenOffice.org modules.

Creating a New Document
There are three ways to create a new Writer document.

* From Scratch  To create a document from scratch,
click File — New — Text Document and a new empty
Writer document is created.

* Wizard To use a standard format and predefined ele-
ments for your own documents use a wizard. Click File
— Wizards — Letter... and follow the steps.

* Templates To use a template, click File — New —
Templates and Documents and choose one of the many
folders (for example, Business Correspondence)
and a new document based on the style of your selected
template is created.

For example, to create a business letter, click File — Wizards
— Letter. With the wizard's dialogs, you can create a basic
document that uses a standard format.

Enter text in the document window as desired. Use the
Formatting toolbar or the Format menu to adjust the ap-
pearance of the document. Use the File menu or the rele-
vant buttons in the toolbar to print and save your docu-
ment. With the options under Insert, add extra items to
your document, such as a table, picture, or chart.

Customizing OpenOffice.org

With OpenOffice.org you can customize the default settings
with the Format menu.
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Below is a list of the most popular options available in most
modules:

Customizing Character Settings
To set all character elements at the same time, select
Format — Character.



Customizing Paragraph Settings
To format paragraphs, select Format — Paragraph and
select the appropriate tabs for making changes.

Customizing Alignment
To modify the alignment, select Format — Paragraph
and choose the alignment you want.

Inserting Headers and Footers
If you want to add headers and footers, click /Insert and
select either Header or Footer.

Inserting Special Characters
If you want to insert special characters, select Insert —
Special Character.

Inserting Footnotes
If you want to insert footnotes, click /nsert and select
Footnote.

Inserting Columns
If you want to insert columns, click Insert and select
Columns.

Inserting Indexes and Table of Contents
If you want to insert indexes or a table of contents, click
Insert and select Indexes and Tables.

The Object Toolbar offers additional text formatting op-
tions.
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Using Master Documents

If you are working with a very large document (such as a
book), you might find it easier to manage the book with a
master document, rather than keeping the book in a single
file. A master document enables you to quickly apply for-
matting changes to a large document or to jump to each
subdocument for editing.

A master document is a Writer document that serves as a
container for multiple Writer files. You can maintain chap-
ters or other subdocuments as individual files collected in
the master document. Master documents are also useful if
multiple people are working on a document. You can sepa-
rate each person’s relevant part of the document into sub-
documents, allowing multiple writers to work on their sub-

documents at the same time without fear of overwriting
each other’s work.

1. Click New — Master Document.
or

Open an existing document and click File — Send —
Create Master Document.

2. Insert subdocuments.
3. Click File Save.

The OpenOffice.org help files contain more complete infor-
mation about working with master documents. Look for
the topic entitled Using Master Documents and Subdocu-
ments.

Using Writer as HTML Editor

In addition to being a full-featured word processor, Writer
also functions as an HTML editor. Writer includes HTML
tags that can be applied as you would any other style in a
Writer document. You can view the document as it will ap-
pear online, or you can directly edit the HTML code.

Click File — New — HTML Document.
2. Press F11 to open the Styles and Formatting window.
3. Click the arrow at the bottom of the Styles and Format-
ting window.
Select HTML Styles.
5. Create your HTML document, using the styles to tag
your text.
6. Click File — Save As.
7. Select the location where you want to save your file,

name the file, and select HTML Document (.html) from
the Filter list.

8. Click OK.

If you prefer to edit HTML code directly, or if you want to
see the HTML code created when you edited the HTML file
as a Writer document, click View — HTML Source. In HTML
Source mode, the Formatting and Styles list is not available.
The first time you switch to HTML Source mode, you are
prompted to save the file as HTML, if you have not already
done so.

Tables

You can include tabular data in the Writer, Impress and
Draw module. Insert basic tables directly into your docu-
ment either with the following menus items or by using the
toolbar:

* Insert — Table,
» Table — Insert — Table,
e or use the Table icon.
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To enter data, select a cell with your mouse pointer and
begin typing. To move around cells, use the arrow keys. — |
moves to the next cell, skipping over the contents of the
cell and Shift + — | moves backwards.

You can use Table menu or the Table toolbar to modify the
table.

OpenOffice.org Calc

Calc is the OpenOffice.org spreadsheet and data-plotting
module. Spreadsheets consist of a number of sheets, con-
taining cells which can be filled with elements like text,
numbers, or formulas. A formula can manipulate data from
other cells to generate a value for the cell into which it is
inserted. Calc also allows you to define ranges, filter and
sort the data, or create charts from the data to present it
graphically. By using DataPilots, you can combine, analyze
or compare larger amounts of data.

As with the entire OpenOffice.org suite, Calc can be used

across a variety of platforms. It provides a number of ex-

change formats (including export to PDF documents), and
can also read and save files in Microsoft Excel's format.
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Creating a New Document

Start OpenOffice.org and select File — New — Spreadsheet
to create a new spreadsheet. Access the individual sheets
by clicking the respective tabs at the bottom of the window.

Enter data in the cells as desired. To adjust appearance, ei-
ther use the Formatting toolbar or the Format menu—or

define styles. Use the File menu or the relevant buttons in
the toolbar to print and save your document.

Customizing OpenOffice.org Calc

Calc comes with a few built-in cell and page styles to im-
prove the appearance of your spreadsheets and reports.
Although these built-in styles are adequate for many uses,
you will probably find it useful to create styles for your own
frequently-used formatting preferences.

Creating a Style

1. Click Format — Styles and Formatting.

2. In the Styles and Formatting window, click either the
Cell Styles or the Page Styles icon.

3. Right-click in the Styles and Formatting window, then
click New.

4. Specify a name for your style and use the various tabs
to set the desired formatting options.

5. Click OK.

Modifying a Style
1. Click Format — Styles and Formatting.

2. In the Formatting and Styles window, click either the
Cell Styles or the Page Styles icon.

3. Right-click the name of the style you want to change,
then click Modify.

4. Change the desired formatting options.
5. Click OK.

Other OpenOffice.org Modules

Besides OpenOffice.org Writer and OpenOffice.org Calc,
OpenOffice.org also includes the modules Impress, Base,
Draw, and Math. With these you can create presentations,
design databases, draw up graphics and diagrams and create
mathematical formulas.

Using Presentations with Impress

Use OpenOffice.org Impress to create presentations for
screen display or printing, such as slide shows or transparen-
cies. If you have used other presentation software, you can
move comfortably to Impress, which works very similarly
to other presentation software.

Impress can open and save Microsoft Powerpoint presenta-
tions, which means you can exchange presentations with
Powerpoint users, as long as you save your presentations
in Powerpoint format.

The OpenOffice.org Novell Edition allows you to use 3D
transitions for your slides. Access the available transitions
by selecting Slide Show — Transitions.

You can either create a brand new presentation (without
any preformatted slides) or use an existing template or
presentation for your new document. Impress uses styles



and templates the same way other OpenOffice.org modules
do. A wizard leads you through the options available for
creating new presentations.
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Using Databases with Base

OpenOffice.org includes a database module (Base). Use
Base to design a database to store many different kinds of
information, from a simple address book or recipe file to
a sophisticated document management system.

Tables, forms, queries, and reports can be created manually
or using convenient wizards. For example, the Table Wizard
contains a number of common fields for business and per-
sonal use. A wizard guides you through the steps to create
a new database.

OpenOffice.org Base comes with several predefined
database fields to help you create a database. A wizard
guides you through the steps to create a new database. The
following steps are specific to creating an address book
using predefined fields, but it should be easy to use the
predefined fields for any of the built-in database options.
The process for creating a database can be broken into
several subprocesses:

Creating a Database
1. Click File — New — Database.
2. Select Create a new database Next.

3. Click Yes, register the database for me to make your
database information available to other OpenOffice.org
modules, select both check boxes in the bottom half
of the dialog, then click Finish.

4. Browse to the directory where you want to save the
database, specify a name for the database, then click
OK.

Setting Up the Database Table
1. In the Table Wizard, click Personal.

2. The Sample tables list changes to show the predefined
tables for personal use. If you had clicked Business, the
list would contain predefined business tables.

In the Sample tables list, click Addresses. The available
fields for the predefined address book appear in the
Available fields menu.

3. In the Available fields menu, click the fields you want
to use in your address book.

You can select one item at a time, or you can shift-click
multiple items to select them.

4. Click the single arrow icon to move the selected items
to the Selected fields menu.

To move all available fields to the Selected fields menu,
click the double right- arrow.

5. Use the arrow keys to adjust the order of the selected
fields.

The fields appear in the table and forms in the order
in which they are listed.

Steps Select fields for your table

1. Select fields This wizard helps you to create a table for your database. After selecting a table category
and a sample table, choose the fields you want to include in your table. You can include
2. Set types and formats fields from more than one sample table.

3. Set primary key Category
4. Create table O B & Parsena
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Creating Graphics with Draw

Use OpenOffice.org Draw to create graphics and diagrams.
You can save your drawings in today’s most common for-
mats and import them into any application that lets you
import graphics, including the other OpenOffice.org mod-
ules. You can also create Flash versions of your drawings.

The OpenOffice.org Novell Edition allows you to import
Scalable Vector Graphics (*.svg) and WordPerfect Graphics
(*.wpg). Select File — Open and use the Filter drop-down
list to view which file formats can be opened.

Creating a Graphic

1. Click Alt + F2 and enter oodraw to open OpenOf-
fice.org Draw.

2. Use the toolbar at the bottom of the window to create
a graphic.
3. Save the graphic.

To embed an existing Draw graphic into an OpenOffice.org
document, select Insert — Object — OLE Object. Select
Create from file and click Search to navigate to the Draw
file to insert. If you insert a file as OLE object, you can easily
edit the object later by double-clicking it.



Opening Draw From Other OpenOffice.org Modules

One particularly useful feature of Draw is the ability to open
it from other OpenOffice.org modules so you can create a
drawing that is automatically imported into your document.

1. From an OpenOffice.org module (for example, from
Writer), click Insert — Object — OLE Object —
OpenOffice.org 3.x Drawing — OK. This opens Draw.

2. Create your drawing.

3. Click in your document, outside the Draw frame.

The drawing is automatically inserted into your docu-
ment.

Creating Mathematical Formulas with Math

It is usually difficult to include complex mathematical for-
mulas in your documents. The OpenOffice.org Math equa-
tion editor lets you create formulas using operators, func-
tions, and formatting assistants. You can then save those
formulas as objects that can be imported into other docu-
ments. Math functions can be inserted into other OpenOf-
fice.org documents like any other graphic object.

Using Math, you can enter your equation in three different
ways:

» Type markup in the equation editor,

* Right-click on the equation editor and select the symbol
from the context menu,

or
+ Select a symbol from the Selection toolbox.

Note

Math is not a calculator. The functions it creates
are graphical objects. Even if they are imported into
Calc, these functions cannot be evaluated.

For More Information

This guide gave you a short introduction to the OpenOf-
fice.org suite. To discover more, refer to Application Guide
(1Application Guide) and the other manuals available for
SUSE Linux Enterprise Desktop at http://www.novell
.com/documentation/sledll/.

OpenOffice.org also contains extensive online help. In addi-
tion, a large community of users and developers support
it. For more details, see the following links:

http://openoffice.org/dev_docs/features/3
.2
A list of all new features available with OpenOffice.org.

http://support.openoffice.org/index.html
Official OpenOffice.org support page, provides manuals
and other documentation

http://www.taming-openoffice-org.com/
Taming OpenOffice.org: Books, news, tips and tricks.

http://documentation.OpenOffice.org/HOW_TO/
index.html
Detailed HowTo's for various OpenOffice.org tasks, in-
cluding how to create and use templates.

Legal Notice

All content is copyright © 2006-2010 Novell, Inc. All rights
reserved.

This manual is protected under Novell intellectual property
rights. By reproducing, duplicating or distributing this
manual you explicitly agree to conform to the terms and
conditions of this license agreement.

This manual may be freely reproduced, duplicated and dis-
tributed either as such or as part of a bundled package in
electronic and/or printed format, provided however that
the following conditions are fulfilled:

That this copyright notice and the names of authors and
contributors appear clearly and distinctively on all repro-
duced, duplicated and distributed copies. That this manual,
specifically for the printed format, is reproduced and/or
distributed for noncommercial use only. The express autho-
rization of Novell, Inc must be obtained prior to any other
use of any manual or part thereof.

For Novell trademarks, see the Novell Trademark and Ser-
vice Mark list http://www.novell.com/company/
legal/trademarks/tmlist.html. Linux* is a regis-
tered trademark of Linus Torvalds. All other third party
trademarks are the property of their respective owners. A
trademark symbol (®, ™ etc.) denotes a Novell trademark;
an asterisk (*) denotes a third party trademark.

All information found in this book has been compiled with
utmost attention to detail. However, this does not guarantee
complete accuracy. Neither Novell, Inc., SUSE LINUX Prod-
ucts GmbH, the authors, nor the translators shall be held
liable for possible errors or the consequences thereof.
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